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Interface Performance

This chapter describes how to view performance information for each of the interfaces on the 
Cisco 12000 series internet router you are managing, using the Cisco 12000 Manager (C12kM) 
application.

There are two performance options in C12kM: the Interface Performance windows and the 
Cisco Element Management Framework (Cisco EMF) Performance Manager application. Performance 
Manager displays historical data as well as current data in the form of a line chart, bar chart, or table; 
Interface Performance windows display only current data in a raw numerical format.

Note Refer to the Chapter 16, “Performance Management and Historical Data” chapter for information on 
viewing historical performance information for a selected chassis, module, or interface using the 
Performance Manager application.

This chapter contains the following information:

• Interfaces and Related Technology-Specific Windows

• Launching the Interface Performance Windows

• Generic Interface Performance

• SONET Interface Performance

• DS3/E3 Interface Performance

• Ethernet Interface Performance

• SRP Side Performance

Interfaces and Related Technology-Specific Windows
Interfaces on line cards can support multiple technologies. Performance windows are 
technology-specific. For example, an POS interface supports two technologies: Generic and SONET.

Therefore, to view the performance of a POS interface, you need to view two windows: the Generic 
Interface Performance window, and the SONET Interface Performance window.

This same process is applicable to all different types of interfaces: POS, DS-3, ATM, SRP or Ethernet.
10-1
Cisco 12000 Manager User Guide



  

Chapter 10      Interface Performance
Launching the Interface Performance Windows
Table 10-1 details which technology-specific performance windows apply to each interface type.

Launching the Interface Performance Windows
Table 10-2 displays the Interface Performance windows that can be launched from each object type. For 
example, the Generic Interface Performance window can be launched from a Site, Shelf, Chassis, 
Module, or Interface object.

Note The Interface Performance windows cannot be opened when multiple objects are selected 
(the menu options to open the Cisco MDM windows are grayed out). Available menu 
options can be launched from a site object containing the required objects, when required.

Generic Interface Performance
The Generic Interface Performance section covers the following areas:

• Viewing the Generic Interface Performance Window

• Starting Performance Logging for a Selected Interface

Table 10-1 Interface Types and Performance Windows

Interface Type Technology-Specific Performance Window

DS-3 Generic, and DS-3

ATM Generic, and SONET

Ethernet Generic, and Ethernet

POS Generic, and SONET

SRP Side SRP Side

Table 10-2 Launching the Interface Performance Windows

C12kM Window/Task

Objects (that can be selected) to Open the 
Window

Menu Options to Select to Open WindowSite Shelf Chassis Module Interface

Generic Interface 
Performance

Yes Yes Yes Yes Generic C12kM Management>Physical>Interface>Generic
>Performance

SONET Interface 
Performance

Yes Yes Yes Yes SONET C12kM Management>Physical>Interface>SONET>
Performance

DS3/E3 Interface 
Performance

Yes Yes Yes Yes DS3 C12kM Management>Physical,>Interface>DS3>
Performance

Ethernet Interface 
Performance

Yes Yes Yes Yes Ethernet C12kM Management>Physical>Interface>
Ethernet>Performance

SRP Side Performance Yes Yes Yes No SRP Side C12kM Management>Physical>Interface>SRP>
Side>Performance
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Generic Interface Performance
• Stopping Performance Logging for a Selected Interface

• Generic Interface Performance Window—Detailed Description

Viewing the Generic Interface Performance Window
To view the Interface Performance window, proceed as follows:

Step 1 Right click (on a relevant object icon in the Map Viewer window or from an object pick list) and select 
the C12kM Management>Physical>Interface>Generic>Performance option. Refer to Table 10-1 on 
page 10-2 for information on which objects allow you to launch the Interface Performance window. The 
Interface Performance window appears, with the Performance (1) tab displayed:

Figure 10-1 Interface Performance Window—Performance 1 Tab

Step 2 Choose a Chassis, Module, and Interface from the list boxes displayed at the left of the window. The 
interface performance information for the selected interface appears in the tabs at right.

Note Transmitted/Received Bandwidth Utilization will not be calculated and displayed until after 
a performance logging poll (15 minutes), and only if performance logging is active for the 
interface.

Not applicable to C12kM
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Step 3 Choose the Performance(2) tab, if required.

Figure 10-2 Interface Performance Window—Performance 2 Tab

The Error Statistics for the selected interface appear.

Step 4 Choose the Performance (3) tab, if required.
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Figure 10-3 Interface Performance Window - Performance 3 Tab

The Packets/Octets statistics for the selected interface appears.

Starting Performance Logging for a Selected Interface

Note Performance logging can also be started/stopped on a global basis for a selected chassis. Refer to the 
“Starting Global Performance Logging” section on page 4-9. Performance logging can also be started 
on a per module (GRP) basis. For details on how to start performance logging for a selected module 
(GRP), refer to the “Module Performance” section on page 5-8.

Starting performance logging allows performance data to be gathered for the selected interface. 
Performance polling occurs every polling period (15 minutes). Performance data is then gathered and 
stored for historical review. Current performance data can be viewed in the Interface Performance 
window, or you can view historical performance data in Performance Manager.

Note You must start performance logging if you want to view historical data in the Performance Manager. 
You do not need to have performance logging enabled on an interface to view the current data in the 
Interface Performance window.

To start performance logging for a selected interface, proceed as follows:
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Step 1 Open the Interface Performance window. Refer to the “Viewing the Generic Interface Performance 
Window” section on page 10-3 for further details.

Step 2 Choose a Chassis, Module, and Interface from the lists displayed at the left of the window.

Step 3 Click Start to begin performance logging for the selected interface. A window appears for you to 
confirm that you wish to start performance logging.

Figure 10-4 Start Performance Logging Confirmation Window

Step 4 Choose Yes to begin performance logging for the selected interface. An Action Report window appears 
to confirm that performance logging has started.

Figure 10-5 Action Report Window

Step 5 Choose Close to close the Action Report window.

Step 6 Choose Close from the File menu to close the Interface Performance window.

Refer to the Chapter 16, “Performance Management and Historical Data”chapter for information on 
viewing historical performance information for a selected interface.

Stopping Performance Logging for a Selected Interface
To stop performance logging for a selected interface, proceed as follows:
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Step 1 Open the Interface Performance window. Refer to the “Viewing the Generic Interface Performance 
Window” section on page 10-3 for further details. The Performance (1) tab appears.

Step 2 Choose a Chassis, Module, and Interface from the lists displayed at the left of the window.

Step 3 Choose Stop to stop performance logging for the selected interface. A window appears for you to 
confirm that you wish to stop performance logging.

Figure 10-6 Stop Performance Logging Confirmation Window

Step 4 Choose Yes to stop performance logging for the selected interface. An Action Report window appears 
to confirm that performance logging has been stopped for the selected interface.

Figure 10-7 Action Report Window

Step 5 Choose Close to close the Action Report window.

Step 6 Choose Close from the File menu to close the Interface Performance window.

Generic Interface Performance Window—Detailed Description
The Interface Performance window contains two tabs: Performance (1) and Performance (2).
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Performance (1) Tab

The Performance (1) tab (see Figure 10-1) contains three areas: General Information, Packets/Octets 
Statistics, and Performance Logging. 

General Information

The General area contains the following fields:

Resets—Number of times the interface is internally reset.

Note Transmitted/Received Bandwidth Utilization will not be calculated and displayed until after a 
performance logging poll (15 minutes), and only if performance logging is active for the interface.

Transmitted Bandwidth Utilization—Percentage of transmitted bandwidth utilization. The percentage is 
calculated as packets per second divided by the speed of interface, averaged over the polling period (if 
performance polling is active).

Received Bandwidth Utilization—Percentage of received bandwidth utilization. The percentage is 
calculated as packets per second divided by the speed of interface, averaged over the polling period (if 
performance polling is active).

Packets/Octets Statistics

The Packets/Octets Statistics area contains the following fields:

In Octets—Total number of packets received on the interface, including framing characters.

Out Octets—Total number of packets transmitted out of the interface, including framing characters. 

In Bits/sec—Five-minute exponentially decayed moving average of input bits per second.

Out Bits/sec—Five-minute exponentially decayed moving average of output bits per second.

In Packets/sec—Five-minute exponentially decayed moving average of input packets per second.

Out Packets/sec—Five-minute exponentially decayed moving average of output packets per second.

In Unicast Packets—Total number of packets received by the layer which were not addressed as 
multicast or broadcast.

Out Unicast Packets—Total number of packets transmitted by the layer which were not addressed as 
multicast or broadcast.

In Multicast Packets—Not applicable to C12kM.

Out Multicast Packets—Not applicable to C12kM.

In Broadcast Packets—Not applicable to C12kM.

Out Broadcast Packets—Not applicable to C12kM.

Performance Logging

The performance Logging area displays Start and Stop buttons.

Start—Click Start to begin performance logging for the selected interface.

Stop—Click Stop to stop performance logging for the selected interface.
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Performance (2) Tab

The Performance (2) tab (see Figure 10-2) displays a single Error Statistics area.

Error Statistics

The Error Statistics area displays the following fields:

Runts—Number of packets input which were smaller than the physical media permitted.

Giants—Number of input packets which were larger than the physical media permitted.

Collisions—Number of output collisions detected on this interface.

Aborted Packets—Number of input packets which were aborted.

Ignored Packets—Number of input packets which were ignored by the interface.

Overrun Packets—Displays the number of input packets that arrived too quickly for the hardware to 
receive.

Misaligned Packets—Number of input packets which were misaligned.

In Errored Packets—Number of inbound packets that contained errors.

In Discarded Packets—Number of inbound packets chosen to be discarded even though no errors were 
found.

In Packets Dropped—Number of packets dropped because the input queue was full. 

Out Errored Packets—Number of outbound packets that could not be transmitted because of errors. 

Out Discarded Packets—Number of outbound packets chosen to be discarded even though no errors were 
found.

Out Packets Dropped—Number of packets dropped because the output queue was full.

CRC Errored Packets—Number of input packets which had cyclic redundancy checksum errors.

Performance (3) Tab 

In Octets—Number of high capacity input octets (64-bit counter)

Out Octets—Number of high capacity output octets (64-bit counter)

In Unicast Packets—Number of high capacity input unicast packets (64-bit counter)

OutUnicast Packets—Number of high capacity output Unicast packets (64-bit counter)

In Multicast Packets—not applicable to C12kM

Out Multicast Packets—not applicable to C12kM

In Broadcast Packets—not applicable to C12kM

OutBroadcast Packets—not applicable to C12kM

SONET Interface Performance
The SONET Interface Performance section covers the following areas:

• Viewing the SONET Interface Performance Window

• SONET Performance Window—Detailed Description
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Viewing the SONET Interface Performance Window
To view the SONET Interface Performance window, proceed as follows:

Step 1 Right click (on a relevant object icon in the Map Viewer window or from an object pick list) and select 
the C12kM Management>Physical>Interface>SONET>Performance option. Refer to Table 10-2 on 
page 10-2 for information on which objects allow you to launch the SONET Interface Performance 
window. The SONET Interface Performance window appears, with the Section tab displayed:

Figure 10-8 SONET Interface Performance—Section Tab

Step 2 Choose a Chassis, Module, and SONET Interface from the list boxes at the left of the window. The 
performance information for the selected interface appears (see Figure 10-8).

Step 3 Choose the Line tab, if required.
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Figure 10-9 SONET Interface Performance—Line Tab

Step 4 Choose the Path tab, if required.
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Figure 10-10 SONET Interface Performance—Path Tab

Note The Virtual Tributary tab is not applicable to C12kM.

SONET Performance Window—Detailed Description
The SONET Performance window displays four tabs: Section, Line, Path, and Virtual Tributary (not 
applicable to C12kM).

Section Tab

The Section tab (see Figure 10-8 on page 10-10) displays a single Section area containing the following 
fields:
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Errored Seconds—Total number of errored seconds encountered by the SONET interface in the current 
15 minute interval.

Severely Errored Seconds—Number of severely errored seconds encountered by the SONET interface 
in the current 15 minute interval.

Severely Errored Framing Seconds—Number of severely errored framing seconds encountered by the 
SONET interface in the current 15 minute interval.

Coding Violations—Number of coding violations encountered by the SONET interface in the current 15 
minute interval.

Line Tab

The Line tab (see Figure 10-9 on page 10-11) displays two areas: Line and Far End Line, as follows:

Line

The Line area displays the following fields:

Errored Seconds—Total number of errored seconds encountered by the SONET line.

Severely Errored Seconds—Number of severely errored seconds encountered by the SONET line.

Unavailable Seconds—Total number of unavailable seconds encountered by the SONET line.

Coding Violations—Number of coding violations encountered by the SONET line.

Far End Line

The Far End Line area displays the following fields:

Errored Seconds—Total number of far end errored seconds encountered by the SONET line.

Severely Errored Seconds—Number of far end severely errored seconds encountered by the SONET 
line.

Unavailable Seconds—Total number of far end unavailable seconds encountered by the SONET line.

Coding Violations—Number of far end coding violations encountered by the SONET line.

Path Tab

The Path tab (see Figure 10-10 on page 10-12) displays two areas: Path and Far End Path.

Path

The Path area displays the following fields:

Errored Seconds—Total number of errored seconds encountered by the SONET path.

Severely Errored Seconds—Number of severely errored seconds encountered by the SONET path.

Unavailable Seconds—Total number of unavailable seconds encountered by SONET path.

Coding Violations—Number of coding violations encountered by the SONET path.

Far End Path

The Far End Path area displays the following fields:
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DS3/E3 Interface Performance
Errored Seconds—Total number of far end errored seconds encountered by the SONET path.

Severely Errored Seconds—Number of far end severely errored seconds encountered by the SONET 
path.

Unavailable Seconds—Total number of far end unavailable seconds encountered by the SONET path.

Coding Violations—Number of far end coding violations encountered by the SONET path.

Virtual Tributary Tab

The Virtual Tributary tab is not applicable to C12kM.

DS3/E3 Interface Performance
The DS3/E3 Interface Performance section covers the following areas:

• Viewing the DS3/E3 Interface Performance Window

• DS3/E3 Interface Performance Window — Detailed Description

Viewing the DS3/E3 Interface Performance Window
To view the DS3/E3 Interface Performance window, proceed as follows:

Step 1 Right click (on a relevant object icon in the Map Viewer window or from an object pick list) and select 
the C12kM Management>Physical>Interface>DS3>Performance option. Refer to Table 10-2 on 
page 10-2 for information on which objects allow you to launch the DS3/E3 Interface Performance 
window. The DS3/E3 Interface Performance window appears, with the DS3 Performance tab displayed:
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DS3/E3 Interface Performance
Figure 10-11 DS3/E3 Interface Performance Window—DS3 Performance Tab

Step 2 Choose a Chassis, Module, and DS3 Interface from the list boxes displayed at the left of the window. 
The DS3/E3 interface performance information for the selected interface appears.

Step 3 Choose the E3 Performance tab, if required, to view the E3 Performance details (see Figure 10-12).
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DS3/E3 Interface Performance
Figure 10-12 DS3/E3 Interface Performance Window—E3 Performance Tab

DS3/E3 Interface Performance Window — Detailed Description
The DS3/E3 Interface Performance window displays two tabs: DS3 Performance and E3 Performance.

DS3 Performance Tab

The DS3 Performance tab (see Figure 10-11 on page 10-15) displays two areas: DS3 Statistics and Far 
End DS3 Statistics.
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DS3 Statistics

The DS3/E3 Statistics area displays the following information:

C-bit Coding Violations—Number of C-bit coding violations encountered by the interface.

C-bit Errored Seconds—Number of C-bit errored seconds detected by the interface.

C-bit Severely Errored Seconds—Number of times C-bit severely errored seconds detected by the 
interface.

P-bit Coding Violations—Number of P-bit coding violations detected by the interface.

P-bit Errored Seconds—Number of P-bit errored seconds detected by the interface.

P-bit Severely Errored Seconds—Number of P-bit severely errored seconds encountered by the 
interface.

Unavailable Seconds—Count of the unavailable seconds encountered by interface.

Far End DS3 Statistics

The Far End DS3 Statistics area displays the following information:

C-bit Coding Violations—Number of far end C-bit coding violations encountered by the interface.

C-bit Errored Seconds—Number of far end C-bit errored seconds detected by the interface.

C-bit Severely Errored Seconds—Number of times far end C-bit severely errored seconds detected by 
the interface.

Unavailable Seconds—Count of the far end unavailable seconds encountered by the interface.

E3 Performance Tab

The E3 Performance tab (see Figure 10-12 on page 10-16) displays three areas: Current E3 Status, 
Interval E3 Status, and Total E3 Status.

Current E3 Status

The Current E3 Status area displays the following information:

C-Severely Errored Framing Seconds—Number of C-bit severely errored seconds encountered by the 
interface in the current 15 minute interval.

C-Line Errored Seconds—Number of line errored seconds encountered by the interface in the current 15 
minute interval.

C-Line Coding Violations—Number of line coding violations encountered by the interface in the current 
15 minute interval.

Interval E3 Status

The Interval E3 Status area displays the following information:

I-Severely Errored Framing Seconds—Number of I-line severely errored seconds encountered by the 
interface in any 15 minute interval.

I-Line Errored Seconds—Number of I-line errored seconds encountered by the interface in any 15 
minute interval.

I-Line Coding Violations—Number of I-line coding violations encountered by the interface in any 15 
minute interval.
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Total E3 Status

The Total E3 Statistics area displays the following information:

T-Severely Errored Framing Seconds—Number of T-line severely errored framing seconds encountered 
by the interface in the current 24 hour interval.

T-Line Errored Seconds—Number of errored seconds encountered by the interface in the current 24 hour 
interval.

T-Line Coding Violations—Number of coding violations encountered by the interface in the current 24 
hour interval.

Ethernet Interface Performance
The Ethernet Interface Performance section covers the following areas:

• Viewing the Ethernet Interface Performance Window

• Ethernet Interface Performance Window—Detailed Description

Viewing the Ethernet Interface Performance Window
To view the Ethernet Interface Performance window, proceed as follows:

Step 1 Right click (on a relevant object icon in the Map Viewer window or from an object pick list) and select 
the C12kM Management>Physical>Interface>Ethernet>Performance option. Refer to Table 10-2 on 
page 10-2 for information on which objects allow you to launch the Ethernet Interface Performance 
window. The Ethernet Interface Performance window appears, with the Performance tab displayed:
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Ethernet Interface Performance
Figure 10-13 Ethernet Interface Performance Window—Performance Tab

Step 2 Choose a Chassis, Module, and Ethernet Interface from the list boxes displayed at the left of the 
window. The performance information for the selected interface appears.
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Ethernet Interface Performance Window—Detailed Description
The Ethernet Interface Performance tab (see Figure 10-13 on page 10-19) displays two areas: General 
Statistics and Collision Statistics.

General Statistics

The General Statistics area displays the following statistics:

Multiple Collision Frames—Count of frames transmitted across an interface where more than one 
collision exists.

Frame Check Sequence Errors—Count of Frames received with Frame Check Sequence Error status.

Alignment Error—Count of Frames received with alignment errors.

Internal MAC Transmit Errors—Count of frames transmitted that failed due to an external transmit error.

Deferred Transmissions—Number of first transmissions attempts delayed because the medium was busy.

Frames Too Long—Number of frames transmitted, where the size of the frames are larger than the 
permissible frame size.

Carrier Sense Errors—Number of times the carrier sense was lost while transferring frames.

Late Collisions—Number of collisions detected on the interface after the transmission of a packet.

Signal Quality Errors (SQE)—Count of SQE error messages generated by the interface.

Single Collision Frames—Count of frames transmitted across an interface with one collision.

Excessive Collisions—Number of times transmission failed due to excessive collision.

Internal MAC Receive Errors—Count of frames transmitted that failed due to an internal MAC receive 
error.

Collision Statistics

The Collision Statistics area displays the following statistics:

Collision Count—Number of collisions per frame on a particular interface

Collision Frequency—The corresponding count of frames for the specified number of collisions.
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SRP Side Performance
The SRP Side Performance section covers the following areas:

• Viewing the SRP Side Performance Window

• SRP Side Performance Window - Detailed Description

Viewing the SRP Side Performance Window
To view the SRP Side Performance window, proceed as follows:

Step 1 Right click (on a relevant object icon in the Map Viewer window or from an object pick list) and select 
the C12kM Management>Physical>Interface>SRP>Side>Performance option. Refer to Table 10-2 
on page 10-2 for information on which objects allow you to launch the SRP Side Performance window. 
The SRP Side Performance window appears, with the Ring tab displayed:

Figure 10-14 SRP Side Performance Window

Step 2 Choose a Chassis, Module, SRP Interface and SRP Side from the list boxes displayed at the left of the 
window. The performance information for the selected interface appears.
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Note The performance dialogs are not applicable to the OC-12 linecards

SRP Side Performance Window - Detailed Description
The SRP Side Performance window displays three tabs: Ring, Host and Errors

Note All the counters that are mentioned in this dialog are subjected to the current 15 minutes interval on 
the device.

Ring Tab

The Ring tab displays four panels: Packets In, Packets Out, Octets In and Octets Out

Packets In 

Low Priority Unicast - Displays the number of low priority unicast packets received from the physical 
layer.

High Priority Unicast - Displays the number of high priority unicast packets received from the physical 
layer.

Low Priority Multicast - Displays the number of low priority multicast packets received from the 
physical layer.

High Priority Multicast - Displays the number of high priority multicast packets received from the 
physical layer.

Packets Out

Low Priority Unicast - Displays the number of low priority unicast packets going to the physical layer.

High Priority Unicast - Displays the number of high priority unicast packets going to the physical layer.

Low Priority Multicast - Displays the number of low priority multicast packets going to the physical 
layer.

High Priority Multicast - Displays the number of high priority multicast packets going to the physical 
layer.

Octets In

Low Priority Unicast - Displays the number of low priority unicast octets received from the physical 
layer.

High Priority Unicast - Displays the number of high priority unicast octets received from the physical 
layer.

Low Priority Multicast - Displays the number of low priority multicast octets received from the physical 
layer.
10-22
Cisco 12000 Manager User Guide

Software Release 2.2



  

Chapter 10      Interface Performance
SRP Side Performance
High Priority Multicast - Displays the number of high priority multicast octets received from the 
physical layer.

Octets Out

Low Priority Unicast - Displays the number of low priority unicast octets going to the physical layer.

High Priority Unicast - Displays the number of high priority unicast octets going to the physical layer.

Low Priority Multicast - Displays the number of low priority multicast octets going to the physical layer.

High Priority Multicast - Displays the number of high priority multicast octets going to the physical 
layer.

Host Tab

The Host tab displays four panels: Packets In, Packets Out, Octets In and Octets Out

Packets In 

Low Priority Unicast - Displays the number of low priority unicast packets received from the higher 
layer.

High Priority Unicast - Displays the number of high priority unicast packets received from the higher 
layer.

Low Priority Multicast - Displays the number of low priority multicast packets received from the higher 
layer.

High Priority Multicast - Displays the number of high priority multicast packets received from the higher 
layer.

Packets Out

Low Priority Unicast - Displays the number of low priority unicast packets going to the higher layer.

High Priority Unicast - Displays the number of high priority unicast packets going to the higher layer.

Low Priority Multicast - Displays the number of low priority multicast packets going to the higher layer.

High Priority Multicast - Displays the number of high priority multicast packets going to the higher 
layer.

Octets In

Low Priority Unicast - Displays the number of low priority unicast octets received from the higher layer.

High Priority Unicast - Displays the number of high priority unicast octets received from the higher 
layer.

Low Priority Multicast - Displays the number of low priority multicast octets received from the higher 
layer.

High Priority Multicast - Displays the number of high priority multicast octets received from the higher 
layer.

Octets Out

Low Priority Unicast - Displays the number of low priority unicast octets going to the higher layer.
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High Priority Unicast - Displays the number of high priority unicast octets going to the higher layer.

Low Priority Multicast - Displays the number of low priority multicast octets going to the higher layer.

High Priority Multicast - Displays the number of high priority multicast octets going to the higher layer.

Errors Tab

The Errors tab displays two panels: Ring and Host

Ring 

Received TTL Expiry Packets - Displays the number of discarded packets received from the physical 
layer, due to TTL expiry

Received Aborted Packets - Displays the number of packets aborted from the physical layer by an abort 
sequence code.

Received Giant Packets - Displays the number of giant packets received from the physical layer.

Note A giant packet is larger than the maximum size packet, which is 9216 octets

Received Short Packets - Displays the number of short packets received from the physical layer.

Note A short packet is 16 octets or less

CRC Error Packets - Displays the number of packets with CRC errors.

Host 

Received Discarded Packets - Displays the number of packets that are not delivered to a higher layer due 
to lack of resources.

Received Giant Packets - Displays the number of packets discarded due to packet size being too big for 
the higher layer.

Received Short Packets - Displays the number of packets discarded due to packet size being too small 
for the higher layer.
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